AgShow
Version 15 Training Manual
AgShow - The Agricultural Show Society Administrator’s Assistant
AgShow consists of an integrated set of modules:
•

Schedule Module: Define your schedule once, then roll it over from year to year. The schedule is
constructed on a section, subsection and class hierarchy. Stewards integrate into the schedule in that
steward positions can be defined and contacts allocated for each section, subsection and class.
AgShow integrates with Microsoft Word to simplify your schedule booklet preparation.

• Entries Module: Easily enter entries as they arrive. Show day reports, such as Stewards Class Sheets
can then be printed at the touch of a button. Entrant details can be rolled over to next year. A
Confirmation of Entry form for each entrant can be used as a Tax Invoice and an outstanding fee
statement.
• Results Module: Integrates with the Schedule and Entries modules to provide quick and easy entry of
results. Once entered reports such as newspaper listings and Prize Certificates can be easily printed.
• Trade Stalls Module: AgShow allows the specification of your trade stall data then helps manage
their hiring including Tax Invoices. GST and insurance can be specified for each site.
• Membership Module: AgShow is constantly being updated. The new Membership module is
integrated into entrant and stall holder details. Membership lists, renewal notices and mailing labels are
easily printed. The Membership module interfaces directly with Microsoft Word’s Mail Merge to
make communication easy and efficient.
• Sponsorships Module: An important income source. This new module integrates with the Schedule
and helps you keep a record of sponsorship fees and payments. Naturally, Tax Invoices are an
important part of this module.
• GST: Tax Invoices for entrants and stall holders are printed by AgShow. GST on prizes for registered
entrants is automatically calculated and added. Tax Credit and other information required by the
Australian Tax Office is collated and produced by AgShow.

AgShow Trial Training Manual

Table Of Contents
1. Overview of Show Administration Activities with AgShow .............................................................................................. 3
Activity A: Preparing the schedule for first use in AgShow ................................................................................................... 3
Activity B: Collating and Printing the Schedule Booklet: ...................................................................................................... 3
Activity C: Processing Entries and the Entry Catalogue Booklet ........................................................................................... 4
Activity D: Reports Required for Show Day ......................................................................................................................... 4
Activity E: Results ................................................................................................................................................................ 5
Activity F: Control Your Memberships ................................................................................................................................. 5
Activity G: Control Your Sponsorships ................................................................................................................................. 6
Activity H: Trade Stall Sites: ................................................................................................................................................ 6
Activity I: End-Of-Year and Future Planning ........................................................................................................................ 7
Activities J: Getting Ready for Next Year ............................................................................................................................. 7
Activities K: Miscellaneous and AgShow Utilities ................................................................................................................ 7
2. AgShow Program Information ........................................................................................................................................... 8
2.1 The AgShow Trial Version 14 Program: ......................................................................................................................... 8
2.2 System requirements: ...................................................................................................................................................... 8
2.3 Installation of AgShow (and the AgShow Trial): ............................................................................................................. 8
2.4 Starting AgShow (or AgShow Trial): .............................................................................................................................. 9
2.5 Uninstalling the AgShow Trial program: ......................................................................................................................... 9
2.6 Your Comments are Appreciated:.................................................................................................................................... 9
3. Some Exercises To Try: .................................................................................................................................................... 10
3.1 Defining the Schedule: Sections, Subsections, Classes, Placings, Stewards and Sponsors: ............................................. 10
3.2 Printing the Schedule: ................................................................................................................................................... 12
3.3 Entries:.......................................................................................................................................................................... 13
3.4 Fees and Special Requests: ............................................................................................................................................ 13
3.5 Show Day Reports – Stewards Class Sheets: ................................................................................................................. 14
3.6 Printing selected User-Defined Headings and Values: ................................................................................................... 15
3.7 Results: ......................................................................................................................................................................... 15
3.8 Prize Certificates: .......................................................................................................................................................... 16
3.9 Trade Stalls: .................................................................................................................................................................. 17
4. Advanced Topic: Using User-Defined Headings .............................................................................................................. 18
4.1 Defining the User-Defined Headings: ............................................................................................................................ 18
4.2 Entering User-Defined Field values: .............................................................................................................................. 18
4.3 Collecting Data for the User-Defined field values: ........................................................................................................ 19
4.4 Specifying what User Defined Headings and Values to Print: ........................................................................................ 19
4.5 Select what you wish to display in the report’s selection form. ...................................................................................... 20
4.6 Print your report: ........................................................................................................................................................... 20
5. Advanced Topic: AgShow Utilities ................................................................................................................................... 21
5.1 Backup and Restore: ..................................................................................................................................................... 21
5.2 Repair and Compact: ..................................................................................................................................................... 21
5.3 Roll Over Files for New Year: ....................................................................................................................................... 22
6. Advanced Topic: Creating Your First Show Data File ................................................................................................... 23
6.1 Preliminary Work: Organising Your Show’s Schedule .................................................................................................. 23
6.2 Starting A New Show Date File in AgShow .................................................................................................................. 23
7. Advanced Topic: Using AgShow to create the Schedule Booklet .................................................................................... 27
7.1 Method 1: Printing the entire schedule booklet from AgShow: ...................................................................................... 27
7.2 Method 2: Printing the competition details from AgShow then Copy/Paste into Word: .................................................. 27
7.3 Method 3: From within Word, importing schedule details using the AgShow Template: ............................................... 28
7.4 Creating a PDF file of your Schedule to put onto your Web Page: ................................................................................. 28
8. Advanced Topic: Within Word, using the AgShow Template to Import Class details .................................................. 29
8.1 Enabling Macros to run in Word ................................................................................................................................... 29
8.2 Installing the AgShow.dot Template............................................................................................................................. 29
8.3 Loading the AgShow Template .................................................................................................................................... 29
8.4 Inserting AgShow Classes into Word for a Single Section ............................................................................................ 30
8.5 Inserting AgShow Classes into Word for a Single Subsection....................................................................................... 31
8.6 Results of Inserting Classes from AgShow ................................................................................................................... 31
8.7 Using Word’s Styles ..................................................................................................................................................... 32
8.8 Unloading the AgShow Template ................................................................................................................................. 33
9. Advanced Topic: Control Your Memberships................................................................................................................. 34
9.1 Defining a Membership Category and Category Fee:..................................................................................................... 34
2

AgShow Trial Training Manual

9.2 Specifying a Membership: ............................................................................................................................................. 34
9.3 Family Memberships: .................................................................................................................................................... 34
9.4 Membership Renewal Notices: ...................................................................................................................................... 35
9.5 Sending a mass communication to your members with Word’s Mail Merge: ................................................................. 35
10. Advanced Topic: Integrating with Word’s Mail Merge ................................................................................................ 36
10.1 AgShow's Mail Merge consists of 3 components: ........................................................................................................ 36
10.2 AgShow's Mail Merge Selection screen: ...................................................................................................................... 36
10.3 Inside Word Mail Merge: ............................................................................................................................................ 37

1. Overview of Show Administration Activities with AgShow
The steps a show secretary may take when using AgShow to help administer a typical show are:
Activity A: Preparing the schedule for first use in AgShow
1. From AgShow's Main Menu select the Schedule Menu then using last years schedule as a guide, enter the show
schedule into AgShow by:
i.
Defining each of the show’s non-cash Prizes (Don't worry if you miss some as you can always add to
the list later.)
ii.
Define each of your Sections, such as Cooking, Goats, Horses. Hint: Do not mix animal types within a
section, eg. Dogs and Cats, because User-Defined Headings are based across a whole section. Even if
Horses and Showjumping will have different User-Defined Headings then they should be defined as
separate sections.
iii.
Define each of your Subsections within each section. This is easy within Cattle etc. as each breed is its
own subsection. Some sections do not break up into subsections, in that case create a subsection
called, say, 'Classes'.
iv.
Define the show Classes for each subsection.
v.
Define the Placings and Prizes for each class.
vi.
Stewards can be entered on a section, subsection or class basis. Specify your own steward (judge? you choose) positions from the Schedule Menu.
vii.
Sponsors can also be specified on a section, subsection and class basis.
viii.
Notes, in RTF (Rich Text Format), can be entered for each section, subsection and class, as well as
notes printed at the beginning and end of the schedule. Examples of notes are Rules and Regulations,
contact names, special conditions etc. Even pictures can be incorporated.
ix.
Some sections require extra information to be collected for each entry, such as a Rider’s Name for
showjumping, or Sale Price for artwork. These optional User-Defined Headings can be specified for
each section.
2. The Cash Prize Lists, particularly the Cash Prizes Summary provides a list of prizes for each class, plus
subsection and section subtotals. This report can also be useful in determining total cash prize requirements.
3. Print the Schedule and distribute each section to the section stewards so they can ensure the information is
correct. When the stewards return their revised listing corrections can easily be made to AgShow.
4. Update Cash Prizes, Set Class Entry Fees and Renumber Class IDs are three AgShow features that allow quick,
easy and accurate updating of last year’s schedule for the next year.
Activity B: Collating and Printing the Schedule Booklet:
5. Once you are happy with the contents of your schedule in AgShow you can print it from within AgShow or you
may need to load it into a publishing program, such as Microsoft Word, so that you (or your publisher) can add
pictures, advertisements and other information to create your final schedule booklet.
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6. There are two methods to load the Schedule into Word:
i. From within AgShow use the Print Schedule option from the Schedule Menu then Print the Schedule
directly to Word. This creates a .rtf (rich text format) document that can be then inserted into any
publishing program, using copy and paste
ii. From within Word, load the AgShow Word Template to directly import schedule details from
AgShow into the current Word document. This method formats the document correctly, even with an
option of using Word Styles, so that you have complete control for formatting the final schedule
document.
7. If changes to class details in AgShow are to be made after formatting your final schedule booklet in Microsoft
Word you do not need to repeat the above steps as the updated class details from AgShow can be inserted
directly into a Microsoft Word document. This is performed within Word on a section or subsection basis using
AgShow's Word Template.
8. If required, print the Sample Entry Form incorporated into AgShow for inclusion with your booklet which
outlines any extra information required for each of your sections.
9. For efficient distribution of the schedule booklet, AgShow can produce mailing labels of entrants from the
previous years show.
10. If you load your schedule onto the Internet then AgShow can make this so easy:
Print each section's schedule to a .pdf document using the PDF button in the Print Preview Toolbar.
Load the .pdf documents onto your web server and point the schedule's links to them.
Activity C: Processing Entries and the Entry Catalogue Booklet
11. From the Entries Menu, select Entry of a Show Entry to type the entries into AgShow as they are received.
12. Extra information, such as a Horse's Name, can be entered when entering entries. You can also open an Entry
Notes RTF editor so that extra information can be entered for an entry to be printed in the Entry Catalogue,
even including a picture of the entrant, or maybe the animal!
13. Email or Post a Confirmation of Entry/Tax Invoice back to each entrant. This ensures the entries have been
typed in correctly, and provides a method of informing entrants of incorrect fee payments. This report also
details all GST payments made by the entrant in entry fees, special requests, membership and gate fees.
14. The Entrants with Fees Owing report is also useful for chasing up entrants who have not paid all of their fees.
The Entrants with Overpaid Fees even has a check box to tick off refunds!!
15. The Special Requests form (selected from the Entry of a Show Entry) allows you to specify any type of extra
request by an entrant. Examples are for particular types of animal pens or stalls, supply of straw, lunches,
caravan sites etc.
16. When all entries have been entered, the Exhibit Numbers can be ordered within each class via a number of
options, including data entry order (default), by entrant name, or by one of your User-Defined Headings, which
may be a Date-Of-Birth. (Reports, such as Stewards Class Sheets and the Entry Catalogue, are ordered by
exhibit number.)
17. The Entry Catalogue Booklet can now be printed that contains the entries for each class that can be distributed
to the entrants within the section.
18. The Entry Count and Entry Fee Income is also a very useful report.
Activity D: Reports Required for Show Day
19. Before show day a number of reports can be printed to help you order prizes, collate and distribute prizes, label
exhibits and list the entrants for each class. These reports are selected from the Show Day Reports Menu and
include:
o Stewards Class Sheets, maybe over 1,000 pages, that contain the entries for each class. These can be
printed onto A4 or A5 sized paper and contain a number of printable options, including entry number
and company (or stud) name.
o Total Prize Requirements, which provides the number of ribbons, trophies etc. required for the show
– very useful for ordering.
o Cash Prize Requirements lists 1st, 2nd, 3rd etc. place prizes for each class, including section
subtotals and grand totals.
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o

Envelope Prize Labels for sections that distribute their prizes immediately. These labels list prize
details for each class and can be pasted onto envelopes containing the prize money, hence streamlining
prize distribution.
o Use the Cash Prize Denomination Report, which specifies how many $100, $50, $20, $10 etc. notes
and coins you require from the bank within each section and subsection, to collect the right amount of
change for filling your envelopes with prize money.
o Entry Labels provide useful identification of exhibits and can be placed alongside the exhibits when
on display. These labels contain the section name, class name and exhibit number. Printable options
also allow the entrant's name and entry number to be included.
o Animal Pen Labels are full A4 paper sized labels that can be printed and posted on an animal’s pen.
Extra information, such as an animal's name, can also be included.
o Ear Tag Labels are label sized for pasting onto an animal’s ear tag. These labels include an animal's
name and tag number selected from the User-Defined Headings.
o Membership Lists for distribution to car-parking attendants and gate keepers so members can easily
be identified.
o Special Request lists. A Special Request can be entered for an entrant, stallholder or member and can
specify whatever you like. For example, animal pen stalls, Caravan Park bookings, even a luncheon
booking/prepayment.
o Sponsorship List can be printed and displayed on a noticeboard.
o Class Location Signs, simply comprise of section, subsection and the class name. These can be
displayed in pavilions to clearly designate the location of the exhibits for each class.
20. Membership Labels, can be printed onto Business Card perforated paper then posted using AgShow’s Mail
Merge. These cards are required to be presented at the gate for free entry. Alternatively, a Membership List
can be printed for distribution to people manning the gates to identify members as they arrive.
Activity E: Results
21. On show day from the Results Menu select the Entry of Placings to enter the results as they filter in.
o Included GST payable to registered entrants is specified when entering results.
o Points can be allocated to each winning entry for determination of any Aggregate Prize competition.
o All figures, that is placing, cash prize, GST included and aggregate points can be altered as necessary
when entering the results, for example, when there are equal first places.
22. Print the Results By Class for distribution to local newspapers, who probably prefer it in Text Only format.
23. Email or print the Results By Entrant. This report contains all of the prizes won by a single entrant, so
enabling easy single payment of prize money to entrants who have won multiple prizes and specifies any
included GST paid to the entrant - that they require for their taxation purposes.
24. The Cash Prize Payout Summary list prizes paid by section, subsection, class or even by entrant.
25. Print the Aggregate Winners list for each section, combined subsections or selected classes.
26. Winners By Prize and Winners By Place provide quick access to view winners for the selected prize or
placing. In particular, the Winners By Prize report is extremely useful for collating information required for
personalised prizes, such as engravings on trophies or for sewings on named sashes.
27. Even design and print your own Prize Certificates all individually printed with the winning entrant’s details.
(The Prize Certificate feature alone could save the Show Society more money than the cost of AgShow!)
Or, if you already have preprinted certificates, print Prize Certificate Labels for each winner and paste them
onto your certificates.
Activity F: Control Your Memberships
28.
29.
30.
31.
32.

Define your own Membership Categories, including family memberships.
Assign Memberships to the contacts and record their Payments.
Email or print and post Membership Tax Invoice that outlines each contact’s memberships and payments.
Membership Lists can be distributed to gate-keepers for clarification of members.
Or, print Membership Labels onto business card sheets so that every member has their own ID card for
presentation at the gate.
33. Membership Renewal Notices can be sent out at the end of each year.
34. The Membership Category Summary lists the count and income for each of your categories.
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35. Use the AgShow to Microsoft Word Mail Merge feature to compose communications with your members.
Letters can be emailed or printed and put into [window] envelopes for posting.
Activity G: Control Your Sponsorships
36. AgShow support for Sponsorships comprises:
o Section, Subsection and Class Sponsorships that are linked to the schedule
o General or Package Sponsorships that are NOT linked to the schedule and printed at the
beginning of lists. Define your own package names, eg. Gold Sponsor Package.
o Each sponsorship record contains:
▪ A Cash Amount, plus GST
▪ A Collector field that is a contact (committee person?) entrusted with the collection of the
sponsorship.
▪ An In-Kind Contribution that comprises:
1. a Description
2. a Value Amount
3. Confirmed and a Collected fields that allow you to monitor each Contribution's
progress.
37. Sponsorships are specified in the Sponsorships By Contact page accessed from the Sponsorships Menu, plus in
the Define Schedule page for Section, Subsection or Class sponsorships.
38. From the Sponsorships Menu:
o Email or print and post a Tax Invoice for each sponsorship.
o Enter the sponsorship Payments as they come in
o Print a Sponsorship List for displaying on a noticeboard at the Show.
o A Collectors List specifies sponsorships assigned to each Collector.
o The Sponsorship Income Summary instantly provides an overview of income and the sections,
subsections and classes it comes from.
o Also an In-Kind Contributions List.
39. Who collects your sponsorship money? In the Sponsorships screen is a 'Collector' field for each sponsorship.
Select a contact who is responsible for, well, collecting the money then the 'Sponsorship List' printed by
'Collector' provides the 'Collectors List'.
40. Use the AgShow to Microsoft Word Mail Merge feature to:
o Send each sponsor a 'Thank-You' letter, which can include the classes sponsored and their results.
o Compose other communications with your sponsors.
o All Mail-Merge letters can be emailed, or printed then put into [window] envelopes for posting.
Activity H: Trade Stall Sites:
Trade Stall Sites are a typical feature of Agricultural Shows for selling showbags and for local businesses to display
and sell their produce. The hiring, allocation and collection of fees for these sites are another administrative task for
the show Secretary. Incorporated into AgShow is a Trade Stall Management System. Steps in using AgShow to
administer trade stall sites are:
41. Define the Stall Sites. Sites can also have Stall Site Extras, such as electricity costs. The 'Extras' are user
defined so could be for anything you require. Hire fees are divided into the general hire fee plus the cost of the
Extras. AgShow clearly shows GST charges included within the fees.
42. Allocate or Assign Stall Sites to stall holders as the requests come in.
AgShow even supports an ‘Early-Bird Discount’!
43. Email or print and post a Stallholder’s Booking Confirmation and Tax Invoice confirming the requested sites
are booked, that fees have been paid correctly and specifying any GST applicable on the fees.
44. Stallholders Site List can be included within the schedule booklet.
45. Trade Stall Allocation and Stallholders Site and Fee lists can be printed for administrative purposes.
46. Extras Listing displays the number and income from each of the Stall Site Extras.
47. For distribution of next year’s promotional material, Mailing Labels of all the previous year’s stall holders can
easily be printed.
48. Or, use AgShow’s Mail Merge feature to communicate with stallholders via mass mailouts or by email.
6

AgShow Trial Training Manual

Activity I: End-Of-Year and Future Planning
49. After your show SoftShow's Annual License Fee is due. The invoice can be printed directly from within
AgShow in the General Menu.
50. AgShow is not an accounting system, but the GST Summary and Cash Prizes Summary reports will provide
valuable data for your taxation commitments.
51. Summary reports, such as the Entry Count and Entry Fee Income in each section or class (selected from the
Entries Menu) provide useful information for planning the schedule for the following year.

Activities J: Getting Ready for Next Year
52. Use the Membership Renewal notices to remind all members of their memberships for the next year.
53. Much of the schedule, stall site information and contact details will be relevant from one year to the next, and
AgShow allows you to reuse this information. The AgShow Utilities program contains an option for setting up
next year’s show file from the data within the current file.
54. The main option in AgShow Utilities is Roll Over Files for New Year that sets up a new data file clearing
entries and stall allocations. Carried over are the schedule, stewards, sponsorships, entrant, membership, stall
sites and stallholder details, so that they do not need to be reentered again.
55. Use the Sponsorships Mail Merge to print a mass mailing requesting sponsors from the previous show to
renew their sponsorship for the next show.

Activities K: Miscellaneous and AgShow Utilities
56. Mailing Labels can be printed at any time for members, entrants, stallholders or any combination of the above.
57. Microsoft Word’s Mail Merge interface enables members, entrants and stallholders name and address details
to be used to produce mass mail-outs. This feature alone could change the way that you communicate with your
membership base, as well as entrants, stewards, sponsors and stallholders.
58. Microsoft Word – AgShow Connection within Word allows formatted schedule information to be directly read
into Word - extremely useful for the schedule preparation.
59. AgShow Utilities is a separate program distributed with AgShow that contains many useful features:
o Roll Over Files for New Year sets up a new .sho data file based on your previous year's data file. The
new data file contains the schedule, contact personal data, trade stall sites but not any entries,
payments, or trade stall allocations. Hence it is almost immediately ready for taking entries for the next
year.
And, the previous year's data file is still intact so can be loaded and viewed at any time.
o Backup and Restore are two important options within AgShow Utilities. The .sho data file contains
the data essential to the running of the Show, so it is important frequent copies of it are made in case of
some mishap.
The Backup and Restore can also be used to transfer the .sho data file from one computer to another.
o Export feature. The schedule which can include entrants and entry information can be exported to a
comma-separated-values (.csv) file that can be used by a spreadsheet program (or similar) for further
refining.
o Import feature. Import directly from Excel into your .sho data file:
(a) Contacts and membership.
(b) Schedule (see AgShow's Help for required fields in the Excel file).
(c) Entries, which may have been generated by an on-line entries program.
o Merge data from one AgShow .sho data file directly into another. Useful if 2+ people are doing data
entry at separate locations.
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2. AgShow Program Information
2.1 The AgShow Trial Version 14 Program:
This AgShow Trial Program is based on AgShow Version 14.1 so is virtually identical to the real AgShow
program, in fact the AgShow Trial’s data files will be able to be read by the main AgShow Program. Therefore, all
the data you enter using the Trial Program will be able to be used if you decide to purchase AgShow.
The AgShow Trial program does contain a few restrictions though:
1. The maximum number of classes allowed per data file is 100
2. The maximum number of entries allowed per data file is 100
3. The maximum number of contacts allowed per data file is 50
4. The Show Society name is locked onto “AgShow Agricultural Show Society”
The demonstration program comes preloaded with a data file called Agshdemo.sho that contains about 90 classes
and 90 entries. Have a play with this file to give yourself a good idea of how the program works.
2.2 System requirements:
• A Pentium 2 GHz or better IBM compatible microcomputer.
• Windows 2000 or later
• CDROM and Mouse.
• 1024x768 screen resolution minimum. (Screen resolution can usually be reset within the Display -> Settings
screen in the Windows Control Panel, or by using a utility program that comes with your video adaptor.)
• 1 GB RAM minimum, 4+GB recommended. (AgShow’s performance improves dramatically with more RAM)
• 1 GB free hard disk space.
• Good quality printer, especially if you are printing your own Prize Certificates.
2.3 Installation of AgShow (and the AgShow Trial):
1. Start Windows in the normal manner
2. Place the AgShow CDROM into your CD drive.
3. AgShow’s setup program, AgShowSetup.exe, will automatically start.
You may have to confirm to ‘Run AgShowSetup.exe’ and allow it to make changes to your computer.
4. After the setup program loads a welcome screen is displayed. Press Next to continue installation.
5. AgShow Trial Setup checks if you have Microsoft Access 2002, 2003, 2007 or 2010 installed on your
computer. If so, AgShow Setup will use the latest version.
Otherwise:
The ‘Access 2010 Runtime is required to be installed’ screen appears.
Read the instructions then click Next which will start the Access 2010 Runtime Installation.
The installation takes a long time so be patient!
When finished, YOU DO NOT NEED TO ‘Continue Online’ FOR USING AgShow.
Just click ‘Close’.
6. License Agreement: If you wish, scroll down and read the Agreement.
Select to accept then click ‘Next’.
7. “Select Destination Location” ensure the location is set to “C:\AgShow”. If, for some reason, you have
AgShow stored elsewhere then click “Browse” to set it to your location.
Click ‘Next’ to continue.
8. Folder Exists: A previous installation of AgShow means that the folder is already there.
Click ‘Yes’ to confirm installation to the ‘C:\AgShow’ folder.
9. Select Start Menu Folder: leave it as “AgShow Trial” which is the name of the program group in the
Start->All Programs. Click ‘Next’ to continue installation.
10. Ready to Install: If the Destination location and Start Menu Folder are as set above, then click ‘Install’.
Note that the installation of ‘Total Access Memo’ by FMSInc also takes place to install the necessary files for
the Rich Text Format (rtf) notes.
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11. Completing the AgShow Setup Wizard: Click ‘Finish’ to, well, finish the installation!
12. If a “File In Use” screen appears during installation then simply press ‘Ignore’ as you must have the file and it
is working perfectly.
13. You may have to restart your computer during installation.
2.4 Starting AgShow (or AgShow Trial):
1.
2.
3.
4.

Start windows.
Click on the Start button on the Task-bar.
Select Programs, then the AgShow program group (or the AgShow Trial group).
Click on the AgShow (or AgShow Trial ) program in this group.

Starting AgShow Trial Version 14:
•

You do not need for a password to start AgShow Version 14.

•

However, because Access 2010 (and 2007) are more security
conscious a Microsoft Access Security Notice is displayed
every time you start AgShow. Simply click the ‘Open’ button
to start AgShow (Trial).

•

Even Access 2003 may ask up to 3 questions.
Answer them so that you continue despite the security concerns.

•

(Some technical information: by obtaining a Digital Certificate
and signing the AgShow program, Microsoft would recognise
AgShow as being Trusted so would not display this message.
However, because of the vast variety of machines and operating
systems AgShow is installed on, on the first startup AgShow compiles itself so that different components
function properly. But by compiling it is deemed to have altered the AgShow program so voiding any
Digital Certificate! I hope to be able to work through this one at a later date.)

•

The first time that you start the AgShow Trial it will set itself up for your computer and, for some reason,
the top Menu Bar does not display. The second+ times you start AgShow Trial everything works fine.

2.5 Uninstalling the AgShow Trial program:
Even if you intend on purchasing the full AgShow program you should uninstall the Trial program.
To uninstall:
1. Close all applications
2. From Windows’ Start button menu click on All Programs→AgShow Trial→Uninstall AgShow Trial
3. Click Yes to Uninstall
2.6 Your Comments are Appreciated:
Help us make AgShow even better. Your suggestions for additional features or reports you would like in AgShow,
or critical comments on the way the current forms or reports are constructed, would be greatly appreciated.

9

AgShow Trial Training Manual

3. Some Exercises To Try:
AgShow Trial should automatically load the C:\Agshow\AgshowTrial.sho data file when installed. To get the feel
of AgShow the following exercises are included to take you through the main features, however still feel free to
explore around the AgshowTrial.sho file. In these exercises the greatest restriction in AgShow is shown to you
almost immediately. The AgShow database is designed on a Section → Subsection → Class hierarchy. So
sections must be defined before any subsections, and the subsections before any classes. That is, a class cannot be
defined that does not belong to a subsection.
If displayed, at the Logon window enter the following Username/Password:
Name:
Password:

AgUser
AgShow

(Press TAB to move cursor to password field)
(The password is cAsE sEnSiTiVe.)

The Main Menu should then be displayed. But, if AgShow has difficulties locating a data file then the Open File
Dialogue Box is displayed first. If so, select the agshdemo.sho (or AgshowTrial.sho) data file.
You can have many data files in AgShow. Open a data file by:
1. From the Main Menu click on the File at the top left menu of the window then select Open.
2. Select the .sho data file agshdemo.sho (or AgshowTrial.sho) to open a little play data file.
3.1 Defining the Schedule: Sections, Subsections, Classes, Placings, Stewards and Sponsors:
1.

The new show section N for Pigs needs to be added. Select Schedule from the main menu, then Define
Schedule from the Schedule Menu.
The schedule details already entered are displayed in the left column of the screen in a schedule tree
format. Click on the plus signs to open up section and subsection details. Click on a section, subsection or
class to view all details for that item.

2.

Click on one of the sections then press the New Section button at the top of the screen. Use the mouse to
position the cursor to the section id. In this case the id is N and the name is Pigs.
The entry fees are usually $2 for members and $3 for non-members.
Standard Prizes in the Pigs section are:
1. Medallion – First and $5 cash – 3 Aggregate points
2. Ribbon – Second and $3 cash – 2 points
3. Ribbon – Third and $0 cash – 1 point
This is what your screen should look like:
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Extra information headings (click the Tab) the Pig Stewards require are:
1. Pig Number
DataType=Numeric - also check the Animal Number field
2. Breed
DataType=Text
3. Pig’s Name
DataType=Text
4. Breeder’s Name
DataType=Text
5. DOB
DataType=Date
The Chief Steward is Freddy Mercury. To select him:
▪ Click on the ‘Stewards’ Tab
▪ Find and click on Freddy in the ‘Select New Steward’ drop-down list?
▪ Then select ‘Chief Steward’ in the ‘Position’ drop-down list
▪ Click the ‘Add New Steward’ button.
The Pigs section does not have a sponsor. Have a look in the ‘Sponsors’ tab anyway.
And, here are your User-Defined Headings and Stewards tabs:

In the schedule we like to include some instructions at the top of the pigs section. These instructions are
entered via the Create Section Notes button at the top of the screen.
Enter the notes:
1. Pigs are to be penned by 10.30am on the day of judging
2. Exhibits must be eligible for registration in accordance with the
Australian Pig Breeders Association

3.

4.

The Pigs section has 2 subsections which are entered by highlighting the Pigs Section in the left column
schedule tree then click on the New Subsection button:
GENERAL subsection has code N-A
TRADE subsection has code … (should be automatically suggested)
AgShow automatically suggests a subsection code, but you can change it, simply by typing over it.
Subsections are a maximum of 4 characters and are ordered alphabetically within each section.
Notice that the section’s entry fees and prizes are copied into the subsection. They can be changed for each
subsection, for example they may be less in a Juniors’ subsection, but we do not need to change them here.
Next step is to enter the Pigs’ class competitions into AgShow.
Click on the GENERAL Subsection within the schedule tree list.
Next click on the New Class button to create a new class form.
GENERAL subsection has the following classes – click the New Class button before entering each one’s
details:
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Class id
N1
N2

Champ
Class
√

N3
N4
√

Name
Boar 6 months and under
Boar over 6 months and under 9 months
Champion Boar
Sow over 6 months and under 9 months
Sow over 9 months and under 13 months
Champion Sow

Note that the entry fees and prizes defined in the parent subsection are copied for each new class.
Prizes for the champion classes are usually different to the normal:
o Select the Champion Boar class by clicking on it in the tree diagram in the left pane.
o Change the first place prize to Main Trophy and give it a substantial cash prize
o Then delete second and third places (click anywhere on them and click the Delete button).
o Similarly, alter the Champion Sow class.
These 2 Champion classes also have their own sponsors:
o Champion Boar sponsor is McDonalds for $10.00. Add by:
1. Select ‘McDonalds Bendigo’ in the ‘Select New Sponsor’ drop-down list
2. Enter $10 in the ‘Sponsorship Amount’
3. Click the ‘Add New Sponsor’ button.
o Champion Sow sponsor – add yourself by:
▪ Click on the Champion Sow class in the tree diagram, then the Sponsor tab in the class details
▪ Click ‘New Contact’ to open the Contacts form
▪ Click the ‘New Contact’ button on that form
▪ Enter your names and town.
▪ Click on the Door button to exit
▪ Now select yourself in the class’s ‘Select New Sponsor’ drop-down list, enter an amount and
click on the ‘Add New Sponsor’ button☺.
Similarly, select the Trade subsection in the Schedule Tree.
Make up some classes for the TRADE subsection.
3.2 Printing the Schedule:
5.

•
•
•
•
•
•

•

Let’s see how AgShow has stored our new classes.
From the Schedule Menu select Print Schedule, which opens up a Schedule Listing Selection form.
Click the Print Preview button.
In the Print Preview, clicking on the little arrows positioned on the bottom left of the screen (either side of
the page number) moves you through the report page by page.
View page two.
Can you find your Pigs section’s details? (including your spelling errors☺). Clicking on the actual page
zooms in and out.
Exit the Print Preview by clicking on the open door icon in the toolbar.
Back at the Print Schedule Options screen, check the Multiple Sections box in the Print Range list.
Select Pigs from the Select Sections list
Click on the Notes Format tab and untick the Print under Schedule Intro and Schedule End.
Then click on the Print Preview button.
Also in the Print Schedule Options screen, by clicking on the “W” button the Schedule report can be
printed directly to Microsoft Word (or any editor that reads RTF files, such as MS Publisher) where final
formatting is performed for your annual schedule booklet, such as headings, instructions and pictures. Try
it – click the “W” button, then again in the small RTF popup screen.
Advanced Topic 7 of this Manual: “Using AgShow to Create the Schedule Booklet”contains helpful hints
on how AgShow can facilitate the collation of your schedule booklet.
Print preview the Cash Prize Summary report in the same way.
The Sponsors List is also worth viewing. Maybe, this list could be printed and posted on a notice board at
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the show.
3.3 Entries:
6.

Once the schedule is sent out entries are returned, so the next task is to enter these entries.
Select Entries from AgShow’s Main Menu, then Enter a Show Entry.
A new entrant, Mr. Don Castle is a registered pig breeder with company (stud) name ‘Castleway’ and
ABN=12345678 so he must also have GST included to any prizes he wins. Don has sent in the following
entries (type dates in as 6 digits. eg: 230510 for the first entry):
Class
N1
N1
N2
N3

Entrant
Pig Num
Ms Darling Castle
4
Mr Don Castle
5
Mr Don Castle
6
Ms Darling Castle
4

Pig’s name
Babe
Porky
Snowball
Babe

Breed
Landrace
Landrace
Duroc
Landrace

Breed by
Ms Darling Castle
Mr Don Castle
Mr Don Castle
Ms Darling Castle

DOB
23-05-2010
03-07-2010
15-01-2010
23-05-2010

Note that Babe has been entered twice (we will ignore the dual sex illegality for this example!). You can
save a lot of typing in the 4th entry above by selecting number 4 in drop-down list in the Pig Number UserDefined Field.
Also enter Porky into class N3 and select his Pig Number so you can see the other fields automatically fill
in. Your screen should look something like, depending on which entry is selected:

3.4 Fees and Special Requests:
Included with the entry form is a cheque for $54 for:
$10 for the above entry fees
$44 membership fee – click the New Membership button (on the Personal Details tab) to add Don as a
new Member. Ensure that the fee is $44 - Exit the Membership screen when finished.
$4 to cover the cost of a pig stall, entered by:
Click on the Special Requests button at the top of the screen.
In the Special Requests data entry form:
• Initially it is empty so click the New Request button.
• Check that Pig Stall is not a previously entered description by clicking the down arrow next to
the Description field.
• Type Pig Stall into the description
• Enter the $4 for the fee, tick GST, Quantity=1 and required for 1 day.
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• Ensure the other fields contain relevant data, GST for the request is automatically calculated.
• Exit the Special Requests window.
Payment for the Entries and Memberships:
1. Click on the Fees tab of the Entries screen.
2. Next click on the Payment button which opens the Payments screen.
3. Enter the $54 into the Amount field. (Note the $54 cheque is now a little short!)
4. AgShow automatically allocates the amount across the different modules. You can simply overtype
the allocated amount if you wish, but AgShow will not accept the payment unless the total
allocated equals the payment amount.
5. Click on the Save Payment button.
6. Click on the Payments History to see the individual payment records across the modules.
7. Exit the Payments screen.
7.

A good practice is to send Mr. Castle a Confirmation of Entry and Tax Invoice form, which ensures
accuracy of entered data - and is a good way of billing entrants when they have included incorrect entry fee
payments.
To print the form:
1.
Select Confirmation of Entries from the Entries menu
2.
Check Single entry by name
3.
Scroll down the entrants list to Castle, Don and click on that row. (Speed up selection in
long lists by starting to type the required surname.)
4.
Click on the Print Preview button and inspect the report.
Note that the amount owing is clearly stated at the bottom.
5.
Exit the Print Preview by clicking on the open door icon in the toolbar
6.
Note the Confirmation of Entry can also be Emailed. Try it.
The Email form is very new and quite involved. Press ‘F1’ to open AgShow Help and read
all about it, as this is how you learn about AgShow. Close Help when finished.
7.
In the yellow Email form, note that Don Castle does not have an email address. Test it by
entering your own email and press the Open in Outlook button. Can you see the
personalised email message with the Confirmation of Entry report attached? Click the Send
button to continue to email it to yourself, or simply close the email form.
Return back to AgShow’s Main Menu by clicking the Exit (Door) button in the opened forms.

3.5 Show Day Reports – Stewards Class Sheets:
8.

After the entries have been entered we now ready ourselves for the show. This is where AgShow really
shines. Reports, which may total over a thousand of pages (we hope so - the length depends on the number
of entries), can be produced at the click of a mouse button. Let’s print the Stewards Class Sheets. This
report is found in the Show Day Reports menu selected from the Main Menu. Let’s see what entries
there are in the show. To do this:
• Select Stewards Class Sheets from the Show Day Reports menu.
• In the Stewards Class Sheets Selection Form click on All sections
• Click the Print Preview button.
• Inside the print preview screen move forward and back through the pages (classes) by clicking on the
arrows either side of the page number display at the bottom-left of the window.
• Close the print preview window by clicking on the Exit icon in the toolbar, or by selecting Close in the
File menu.
• There are numerous options in the setup form, so read through them and maybe try some. Eg. Can you
specify the page heading as ‘Judges Class Sheets’? And, some shows like to have a Placings Slip
printed at the bottom of each page.
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3.6 Printing selected User-Defined Headings and Values:
More information on User-Defined Headings is in “Advanced Topic 4” of this booklet.
9.

Note that the Pigs Stewards Sheets included the breed, pig’s name and breeder details. The printing of each
of these can be turned on or off from within the Define Schedule screen, so exit back to the Main Menu
then click on Schedule and then Define Schedule.
From within the Define Schedule:
• Select the Pigs Section on the left
screen then the User-Defined
Headings tab.
• Notice the “Print Hd Val” checkbox
columns.
• Set these (by clicking the squares) to
match the diagram.
• In the Stewards Class Sheets, plus
most other reports, this will print the
values of the Pig Number and Breed
plus the heading “Pig’s Name=”
followed by the pig’s name value.
The Breeder’s Name is not printed and the DOB value will be printed with the “DOB” heading.
• Exit Define Schedule to the Main Menu then select Show Day Reports and Stewards Class Sheets
• Ensure ‘Selected’ is selected in the Special Headings rectangle.
• Print Preview the Pigs section to see the extra information that is now included in your report.

10.

Whilst in the Show Day Reports menu, see what the Total Prize Requirements for the Trial Show are.

3.7 Results:
11.

On show day, results filter back to the secretary. If a computer containing AgShow is housed in the
Secretary’s Office these results can be entered immediately. Using a portable laptop would provide even
more flexibility. Mr. Don Castle’s entries are very successful in the Pigs section, so let’s enter his results.
Select the Entry of Placings option in the Results Menu.
In ‘Current Class Details’ in the middle of the form select:
Section: N Pigs, the Subsection: N-A General and the Class: N1 Boar.
Mrs. Darling Castle’s Babe, exhibit# 1, is first in class N1, with Mr. Don Castle’s Porky (exhibit# 2)
second. (Normally results are entered from details on the Stewards Class Sheet which contain all of each
entry’s details.)
In class N2 exhibit# 1, Mr. Don Castle’s Snowball, gained first place.
Note that AgShow also fills in the Aggregate Points column and any Included GST for registered entrants,
both of which you can overwrite if you wish. The Aggregate Points value is used to determine winners in
aggregate prizes.
Also Mrs. Darling Castle’s Babe has won the Champion Boar class, which is entered by:
• Select Pigs in the Select Section drop-down list at the top of the Show Results Entry form.
• Select class Champion Boar.
• Check the Section box in the Select Entrant From options which will then list all entries within the
section in the drop down box.
• Select the correct entrant, exhibit#1 from class N1, from all entries in the section.

12.

From the Results Menu select Results By Entrant and print the results of Mr. Don Castle. This is a very
useful list for a single payment of all prize money to entrants with multiple winnings, even across sections.
Plus it can even be Emailed to each entrant.
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The Results by Class report is also very handy for distribution of results to the local newspapers. Your
local newspaper may even prefer to have this report as a file, instead of as a hardcopy. To achieve this, for
any report, select Output To from the File menu within the Print Preview screen. Print the report as a
Rich Text Format - .rft file. This file will be readable by any modern word processor.
But, for show administration, the Cash Prize Payout Summary lists the sum of prizes allocated. (Maybe,
in a future version of AgShow you will be able to tick off against each entrant when the prize is actually
paid, but for now it is prize allocated.)
13.

Aggregate Prize list:
AgShow supports aggregate prizes, even across different sections.
• Aggregate points for every placing are specified in Define Schedule then can also be altered when
selecting winning entries in the Entry of Placings form.
• View Aggregate Winners from the Results Menu
• Highlight one or more of the sections
• Print Preview the aggregate results

3.8 Prize Certificates:
14.

AgShow can save money by printing Prize Certificates on coloured card. All you need to do is create your
certificate design in a graphic program (or scan your current certificate) to print colourful certificates
containing section, class and winning entrant information. An example has been included with the
demonstration program:
• Select Prize Certificates from the Results Menu
• To load the example setup click the Load Setup button and select “agshow_1st_2pp.cert”
• Click the Preview button – Wow!
• Click the next page button (right triangle) on the bottom-left to browse through the winners.
• The certificate is made up from graphic images, database content and entered text.
• Exit the preview (Door on the toolbar) and select the Text Boxes tab.
• Change the 2008 to 2010 then Preview the results
• Exit the preview again and select the Graphics tab.
• Click on the Select button next to the Background Image heading.
• Select the file “bend3rd2pp.JPG” file then click Preview again.
Hmmm! Setting up certificates does require a little bit of playing around.
• Reselect for the Background Image “agshow_cert_180x130.jpg” and check the Print Preview.
• You can save your new certificate setup by pressing the Save Setup button.
Call your setup DemoTest (Do not use one of agShow’s names as it will be overwritten every time
you install AgShow.)
• Load Setup “agshow_2nd_4pp.cert” and Print Preview. As this shows 4 certificates per page.
• Have a play around with the certificates.

15.

Other lists you will find useful include:
• Entry Count by Section in the Entries menu.
• Print Sample Entry Form also in the Entries menu. The Secretary’s address can be altered in the Set
Base Details form from the End-Of-Year menu.
• Envelope Prize Labels in the Show Day Reports menu. These labels are useful for pasting on
envelopes to make the distribution of prize money easier.
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3.9 Trade Stalls:
16.

Investigate the Trade Stalls menu by setting up the following stalls in the Initial Stall Information of the
Trade Stalls menu.
Add sites 20 and 21, both in the Central Hall and all based on the same values as Site# 1.
So, select site# 1 then click the “New Stall Site” button.
In the new record alter the Site# field to 20.
Water and power are available so ensure they are ticked. Actually, power is an Extra $5 fee so we will
enter this as a Stall Site Extra instead of the Insurance as displayed.
First we need to create the Extras record for Power:
• Exit back to the Trade Stalls Menu
• Click on Stall Site Extras
• New Extra, name it Power, Normal Fee = $5 then whatever you like.
• Back to Stall Site Setup and select Site# 20
• In the Stall Site Extras, delete Insurance by clicking Remove Extra
• Select Power in the Extras drop-down list then click Add New Extra.
Site# 20 is complete, so Click the New Stall Site button again then alter the Site# to 21.
How easy is that?
Assign one of these sites to Sandhurst Trustees Ltd., managed by Mr Sandy Hurst:
•
Select Assign sites from the Trade Stalls menu.
•
Click on the New Contact button
•
Enter the details for Sandhurst Trustees
•
Allocate one of your new sites to Sandhurst.
•
Exit to the Trade Stalls Menu.
•
After booking the site we need to send out a Stallholder's Confirmation to Sandhurst
Trustees. From the Stallholder Confirmation selection form click on Single Stallholder
by Name then select Sandhurst. Look at a Print Preview of the report.
•
Print Preview each of the other available reports in the Trade Stall Menu.
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4. Advanced Topic: Using User-Defined Headings
Some sections require more detailed information to be collected on each entry other than entrant name.
For example, the Horses section might require Horses Name, the Art section Price, Showjumping section
probably requires Horses Name plus Rider, etc.
In AgShow, such extra information is defined on a section basis, as each section (obviously?) requires
different information. The User-Defined Headings tab in the Define Schedule is where such information
is defined. The values are entered when entering entries.
This extra information can be printed in reports, such as the Stewards Class Sheets and the Entry
Catalogue, which may be handy for judges or announcers.
4.1 Defining the User-Defined Headings:
Before any data can be entered, the Heading for the information has to be defined.
In the ‘Schedule Menu -> Define Schedule’ screen, the User-Defined Headings tab is where they are
entered for each section. Press the ‘F1’ key to read AgShow’s Help page on using this screen.
Controls on this screen are:
• New Heading button creates a new row.
Type in your heading.
• Animal Number: one heading can be
selected which is then a Key field and
must be of type Numeric. If an animal is
entered in many events the extra data
has to be entered for the first event, but
for subsequent events selecting the
animal’s number will automatically fill
in the values for the User-Defined fields.
• Data Type: can be Text, Numeric or
Date. AgShow enforces values to
conform to the data type when entering
entry values.
• Print Hd and Val: specified whether the Heading and/or Value for each entry are printed in
reports, such as Stewards Class Sheets and Entry Catalogue.
• Up/Down arrows: at top/bottom left side are used to move the order of a heading.
4.2 Entering User-Defined Field values:
The data entry screen for the “Enter a Show Entry” contains a column for the User-Defined fields which
is updated whenever the current entry is changed.
The following screen shows:
• The current entry is entry# 144
• The exhibit number, entry fee and entrant name are displayed with the entry information.
• Entry# 144’s User-Defined Headings and values are displayed in the right column.
• Some sections may have many User-Defined Headings and you may not have values for all of
them. A heading can be removed from this entry’s list by pressing the Remove Heading button.
This does not delete the actual heading, just removes it from this entry’s list. It can be relisted by
pressing the Add Heading button.
• A new entry is created by pressing the New Entry button. If it is another Goat entry for the goat
“You Idiot”, then selecting number 3 for the Goat Number in the new entry will populate the UserDefined Heading values with those previously entered for goat# 3.
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4.3 Collecting Data for the User-Defined field values:
AgShow allows an endless number of User-Defined Heading fields to be created, but data for each entry
now has to be collected and entered. How does the entrant know what information is required for each
entry? You may have your own customised Entry Form with the fields clearly specified. Alternatively,
AgShow can print a list of the User-Defined Headings for each section that can be included with
promotional material or within the schedule booklet.
The list is selected from the Entries Menu.
4.4 Specifying what User Defined Headings and Values to Print:
Some sections may have many User-Defined fields and you might want to only print some of them in a
report.
In the ‘Schedule Menu -> Define Schedule’ screen, inspect the User-Defined Headings tab in each
section. Notice the two columns in the User-Defined Headings called Print ‘Hd’ (heading) and ‘Val’ (the
entry value). Instead of printing every heading and value in reports like the ‘Entry Catalogue’ and
‘Stewards Class Sheets’, AgShow now give you the option of only printing those headings and values
that are ticked. Initially all headings should be ticked, so now ‘untick’ the headings and values you do
NOT wish to be printed in your Entry Catalogue, or Stewards Class Sheet etc.
The picture below shows that only the Goat Number and Goat Name values will be printed, but the
heading “Handler”’s name will be printed with the entry’s value.

Note that these heading and value selections can be altered before printing any report.
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4.5 Select what you wish to display in the report’s selection form.
For example, shown below is the Results By Class selection form. The Special Headings table shows
that what will be printed is what is selected in the Define Schedule form, as above.

4.6 Print your report:
The report as defined above is shown below. Note that the Goat Number and Goat Name are printed
without the heading name, whereas the “Handler’s Name” is printed before the handler, as specified in
the Define Schedule. (Not every entry has a value in every defined heading.) Remember also that the
heading and field value specification as defined in Define Schedule can be altered before printing any
report.

20

AgShow Trial Training Manual

5. Advanced Topic: AgShow Utilities
The AgShow Utilities program provides many general file-handling functions for AgShow.
•
•

The Roll Over Files for New Year copies schedule, stall site, membership and entrant data into a
new data file. This new file does not have the entries, results or stallholder allocations, so provides
a base for starting the next year.
The Repair and Compact options can be used to recover from difficulties AgShow has reading
your data file.

The Utilities program is a separate program to AgShow and is started by clicking on the AgShow Utilities
icon in the AgShow group in the All Programs list.
Do not start the AgShow Utilities program whilst AgShow itself is running. AgShow Utilities uses
some of the files that AgShow also uses and both programs trying to access them at once can give
unpredictable results.
5.1 Backup and Restore:
From Version 15 the Backup option is also
available in the General Menu of AgShow. (Easily
accessible so now there is no excuse for not having a
backup!)
The Backup option allows you to easily copy your
show data file to a floppy, flash drive or any other
storage media. This option also compresses the file as
it copies, storing it as a “.arj” file.
Simply press the ‘Select File to Backup’ button,
select your .sho data file from the OpenFile Dialogue
box, then press Backup.
By default, AgShow will backup your file to the ‘C:\AgShow\backup’ folder and automatically append
the date and change the extension.
To backup onto a removeable Flash Drive, select the file to backup, then click the ‘Select Different
Destination’ button. Then in the Open File Dialogue box navigate to your flash drive and press the Save
button.
The Restore option copies a “.arj” data file back into your AgShow directory.
It is good practise to backup your data “.sho” files periodically. When taking entries it is advisable to do
this daily. I suggest using 5 floppy drives, one for every day of the week. Plus, once a week do an extra
backup and take that floppy home.
5.2 Repair and Compact:
It is possible that you “.sho” data file may become corrupted. Suddenly losing power whilst AgShow is
open is one way that this can happen.
Symptoms of corruption are missing data items in lists, or a sorted list not sorting correctly!
Never fear! AgShow saves all data virtually immediately that it is entered and running the Repair and
Compact option should rebuld your data file correctly.
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5.3 Roll Over Files for New Year:
Entering the schedule data is one of the biggest tasks for the show secretary. Fortunately, with AgShow
you only need to do that once, as for the following year a new data file can be created based on the
schedule of the previous year. Then load the new data file, make the adjustments to the schedule as
necessary and you are already ready for the entries to come in for new year.

The screen above shows that the agshdemo2008.sho has been selected and will be copied to the data file
agshdemo2009.sho.
In the new data file agshdemo2009.sho:
• All schedule information, such as sections, subsections, classes, placings, sponsors, stewards etc.
will be the same as in the 2008 data file.
• Unassigned Contacts will be deleted. (An Unassigned Contact is one that in the 2008 file was not
an entrant, member, steward, sponsor, stallholder etc.)
• Entries data will be deleted
• Special Requests data will be deleted
• Also, all trade stall sites will be unassigned and sponsorship payments deleted.
• All Memberships data will be the same as in 2008, so a historical list of memberships is kept.
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6. Advanced Topic: Creating Your First Show Data File
The very first time you use a program is always a little scary. Especially if you know what fantastic things the
program can do, because you can’t help wondering if you will be able to do those things as well.
You may end up using AgShow for many years, but because you can use the same data file year after year you will
possibly only need to set up the very basic information once. And unfortunately, that is the very first time you use
AgShow!
6.1 Preliminary Work: Organising Your Show’s Schedule
The schedule in AgShow is organised on a section, subsection and class basis:
• Section: different areas of your competitions, such as Homecrafts, Cooking, Goats, Horses, Photography
etc. are each defined as a Section.
• Subsection: competitions within a section are grouped in subsections. Eg. The Horses subsections may be
Clydesdales, Australian Ponies, Thoroughbreds etc.
• Classes: The individual competitions within each subsection. You MUST create a subsection before you
create classes.
• Prizes: Each class has a number of prizes, such as “Certificate First Prize”, “Champion Ram Sash” or
“Fred’s Memorial Trophy”. Every different prize you have needs to be specified in AgShow, even if it is a
trophy for one class. You should also specify each of your champion sashes individually.
Each prize must be provided with a unique Prize_ID identifation code, up to 4 characters.
So, before starting AgShow get your previous year’s schedule booklet and highlight the sections, subsections
within each section and classes within each subsection. (Note, in AgShow a subsection must be specified under a
section and classes must be grouped under subsections. Small sections may not require a subsection, but for
AgShow you will have to create one, for example, General or Classes.)
6.2 Starting A New Show Date File in AgShow
1. Start AgShow as normal (select AgShow from the Start→Programs→AgShow menu)
Name:
Password:

AgUser
AgShow

(Press TAB to move cursor to password field)
(The password is case sensitive.)

2. From the Main Menu create a new data file by selecting from the top menu bar:
File→New Show Database
3. AgShow displays the Open File dialog window displaying files from the AgShow directory. In the File name
field type the name of your show data file. It is recommended you add the year of the show to the name.
eg. BEND2010.SHO (use an abbreviation for your society instead of BEND)
AgShow will automatically add the .SHO to your file name if you leave it off.
Press the Open button after typing the name.
4. Now you need to load this data file by selecting
File→Open
Double-click on your new data file name.
You now have a completely empty data file, but showing the wrong society name etc.
5. Altering the base details:
Click on the End-of-Year button then Set Base Details.
Change the show name, show date, membership fee, secretary name etc.
AgShow does its best to obtain a date from any method you type it in, or some users find it easier to select
dates by pressing the appropriate calendar button.
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Set your GST options as appropriate.
(These base details can always be altered again at any time)
6. Exit back to the main menu.
Now we will start entering details of your schedule, so it will be useful to have a copy of your previous years
schedule booklet on hand.
The schedule is broken into sections, which contain subsections where the classes are defined. Each class has a
list of prizes and the first task is to specify the prizes we are going to use.
7. Specifying Prizes:
From the Main Menu select Schedule then Define Prizes.
Click the Add New Prize button. Prizes are physical things the winner is awarded, such as sashes, ribbons,
certificates, trophies etc. Additional cash prizes are specified when entering class details. Some prizes have
been predefined for you.
Each prize requires a code (1-6 characters) that you make up plus a description. Try to use some sort of system
for the code, some examples are:
Code
Description
R1
Ribbon Blue – first place
R2
Ribbon Green – second place
EWT
Earnest Watts Memorial Trophy
Every different prize you use should be specified in this screen, including trophies and sashes given for only a
single class. But, as they can be added at any time simply enter the basic prizes for your first section for now.
When done Exit the prizes screen.
(Note: the Prize Requirements report prints every prize and the number required. So specifying every Sash
content in detail will provide a list of requirements later.
8. Specifying Sections, Subsections and Classes:
Select the Define Schedule button on the Schedule Menu.
Click on the New Section button
Enter the code and name of one of your sections, eg:
A Cooking
then press the Okay button.
You can alter the section code, but it cannot be left blank, must be less than or equal to 3 characters and must
be unique across all sections.
9. Entry Fees:
Enter the normal entry fees for members and non-members. At this point use the normal values within the
section. They will be copied to any subsections created in this section where they can be altered for any
different subsections. Then, when creating new classes the subsection values are copied, but again they can be
altered for each class. It is the Entry Fees and Prizes specified in the Class screen that are actually used for
entries. Entry Fees can even be individually altered again on an individual entry basis when entering each show
entry.
10. Standard Prizes:
Define up to six standard prizes for classes in this section. The prize is selected from the drop-down list (did
you specify the prize in the Define Prizes scteen?) and enter the cash prize. These prizes are a suggestion for
each subsection. Actual prizes used are specified in the Classes screen and can be easily altered in any class
that has a different set of prizes.
11. Sponsor and Stewards tabs:
Unfortunately, you cannot simply type in the stewards names, as they have to be defined as a contact in
AgShow’s database. If you do type something in these fields you will have to rub it out with the delete or
backspace key.
If you wish to specify a Sponsor or Steward and they have not yet been entered as a contact then click on the
New Contact button. Enter the steward’s personal details then Exit back to the section screen. You should now
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be able to select your new contact from the drop-down lists in the Sponsor and Stewards fields.
12. Extra Information Headings:
Some sections require more information for each entry than other sections. For example Horse sections may
require the rider’s name, which is something that is irrelevant for the Cooking section. Enter any headings for
your section here. You can add or change them later.
Two tick boxes appear on the right of each heading that specify whether the heading (Hd) and the entry’s value
(Val) should be printed in various reports. For example, the heading “Horse Name” may have a value “Hi-HoSilver” for a particular entry. Ticking both will make the text “Horse Name=Hi-Ho-Silver” appear in the Entry
Catalogue, Stewards Class Sheets and other reports. Only ticking the Val column will, in this example, only
print “Hi-Ho-Silver”. Leaving both boxes unticked will mean this heading or value will not be printed on these
reports. These boxes can be ticked and unticked as required just prior to printing such reports.
Also set the Data Type for each heading. AgShow will enforce that data entry for Number and Date types are
correct when you enter show entries.
13. Section Notes:
Most sections have notes containing rules and regulations printed in the Schedule Booklet immediately after
the section heading.
Click the Create Section Notes button to bring up a small notepad window if you wish to enter some notes for
this section.
Exit the Notes notepad screen when finished.
14. Subsections:
The classes within most sections are organised into subsections. For example the Cooking section may contain
Bread and Cakes as two subsection headings.
In AgShow classes are entered under a subsection heading, so even if a section is not grouped into subsections
a subsection must be defined anyway. In that case give the subsection some unobtrusive name such as General.
Click on the relevant section in the left column of the Schedule screen then click on the New Subsection
button.
Each subsection must have its own unique code. AgShow will suggest a code that corresponds to an alphabetic
sequence, such as A-A, A-B, A-C … for subsections in section A. You can change the codes if you wish, but it
must be unique within the section. Subsections are ordered alphabetically within each section by the
subsection code.
Also enter the subsection’s name then click on the Okay button.
The entry fees and standard prizes are copied from the section screen. Change them if they are generally
different for this subsection.
15. Defining Section Classes:
The classes are the individual competitions of the show.
In the left column of the schedule screen click on the relevant subsection for the new class then click on the
New Class button.
16. Class id Code:
AgShow has a ‘guess’ at the class id code, probably A1 if you specified section A. You can alter this to
whatever corresponds to your schedule booklet, including leaving it blank. (Generally, champion classes do not
have a class id).
17. Class Name and Entry Fees:
Enter the name and description.
The normal Entry Fees for the subsection are copied for this class. Alter them if necessary.
18. Champion Class:
Tick the box if this class represents a Champion class. Notice that the Class ID code is made blank and the
entry fee set to zero for a Champion class. You can retype a Class ID code and specify entry fees if you wish.
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19. Class Places and Prizes:
The standard places and prizes defined for the subsection are copied here but can be altered for each individual
class.
Click the New Place button in the Places and Prizes window.
The place field can be any 3 characters, but they usually follow the sequence 1, 2, 3… Be careful not to add
spaces within the characters as they alter sorts and searches considerably!
Select the prize from the drop-down list of prizes you specified earlier.
Enter the cash prize for the place.
Champion classes usually have only one prize – a Sash or equivalent (which should be specified in the Prizes),
so these will have to be altered on an individual basis.
Places can easily be added, deleted and edited at any time.
These are the prize specifications AgShow actually uses for each class. The prizes specified in the Section and
Subsection screens are just for general information.
As results are added against these Placings, if you do not specify any Placings then you will not have anything
to enter results against.
20. Class Sponsor:
Is printed in the schedule under the class description. You can only select a class sponsor from the drop-down
list (if you type a name in you will have to rub it out using the backspace or delete keys), so click the New
Sponsor button to add a new contact’s details if necessary.
21. Affiliations:
Often sets of results are required to be sent to an affiliated body, such as Victorian Agricultural Shows Ltd
(VAS), or horse, cattle or dog breeders associations. Such affiliations can be defined in the Schedule Menu
then selected for the corresponding classes.
22. Class Notes:
Some classes require their own little descriptive text to be printed in the schedule, such as a recipe for a
cooking class. This text can be added by pressing the Create Class Notes button.
23. Add a few other sections, subsections and classes then exit to the Schedule Menu. Press the Print Schedule
button then Print Preview the schedule so you can see how the information you have entered will eventually
look.
After following these few instructions you should now have a good start at using AgShow and be able to add all of
the sections, subsections and classes of your schedule. And that is not a small task!
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7. Advanced Topic: Using AgShow to create the Schedule Booklet
Creating the Schedule Booklet is one of the hardest and most time-consuming tasks that the Show
Secretary has.
Many show societies have their schedule booklet constructed within a Word or Publisher file and these
files may be quite complex containing the Society’s Rules and Regulations, different section’s Rules and
Regulations, logos, advertisements etc. This booklet is updated from year to year.
Reports of AgShow that you can collate into a final schedule booklet are:
• Print Schedule that lists the sections, classes, entry fees, prizes, stewards, sponsors etc,
• Sponsors List from the Sponsorships Menu that lists all sponsors. Copy and Paste the report into
your schedule booklet.
• Membership List to list all Life Members.
Below are 3 methods where you can use AgShow to update the booklet (although you will probably use a
mixture from them):
7.1 Method 1: Printing the entire schedule booklet from AgShow:
AgShow’s Notes is a main feature for the construction of a detailed schedule booklet.
Notes are stored as Rich Text Format (.rtf) files so can contain formatting such as different fonts, bold,
italics and even pictures.
Notes can be entered for each Section, Subsection, Class and even for the Beginning (Intro) and End of
the schedule.
So, this is where Rules and Regulations for the show or sections can be entered.
Notes are entered into AgShow from the Define Schedule screen.
Now simply print the schedule using the Print Schedule option in the Schedule Menu.
Or better still, Print Schedule directly to Word using the ‘W’ button then you can add advertisements etc.
Advantages:
• All information is within AgShow, so there is no duplication.
• Print the schedule directly to Word (using the ‘W’ button) as a Rich Text Format (.rtf) file so that
final editing can be done in Word.
• If the local print shop controls your Schedule Booklet file, then printing the schedule using the
‘W’ button in the Print Schedule screen produces enough information for the printer to update
their copy of the schedule.
Disadvantages:
• AgShow’s notes editor does not contain as many features as Word, or other publishing programs.
• Each Note (section, subsection or class) has to be edited separately, so you do not see the overall
appearance until you print the schedule (you can Print Preview it).
• No control over page breaks, so very difficult to insert advertisements etc.

7.2 Method 2: Printing the competition details from AgShow then Copy/Paste into Word:
If your Schedule Booklet document file(s) in Word is something not so easily reproduced, then you might
just like to update it from year to year. For example, often Poultry sections have their classes listed in a
shorthand tabular format that AgShow cannot reproduce.
This basically means that you will have your schedule duplicated, one copy of the schedule in your
Booklet document and the other in AgShow. One way of managing this is:
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•
•
•
•
•

Make all of your schedule changes in AgShow. Changes may be minor, such as changes in prizes,
or major such as a new subsection or a complete reorganisation of a section.
AgShow is now ready for taking entries etc.
Duplicate minor changes in the Schedule Booklet document in Word.
For major changes, print the schedule from within AgShow to Word using the ‘W’ button in the
Print Schedule screen.
Now copy/paste the relevant parts from the AgShow copy to your Schedule Booklet document.

Advantages:
• You probably do not need to enter the Notes pages into AgShow, so making schedule
maintenance in AgShow easier.
• Your Schedule Booklet document keeps a consistent format, as you are reusing the same base file
from year to year.
Disadvantages:
• Some duplication of changes are required between the 2 copies of the schedule.
7.3 Method 3: From within Word, importing schedule details using the AgShow Template:
This is very similar to Method 2 above, except you do not need to print a copy of the schedule from
AgShow. Again, you have a separate Schedule Booklet document.
• Make any changes to the schedule in AgShow
• When collating your Schedule Booklet document, class details can be directly retrieved from
AgShow into your booklet.
• Class details are retrieved on a Section or Subsection basis.
• See Advanced Topic 8 of this Training Manual (on the following page) for details on using the
AgShow Template.
Advantages:
• Very easy to update your Schedule Booklet document as it does not require copy/paste between
two files. In fact, you are only editing within the Schedule Booklet document.
• You can select exactly what data to import.
• Incredible Formatting Flexibility: You can select the imported data to be formatted using Word
Styles. This provides you with incredible power and flexibility for formatting your Schedule
Booklet. Eg. Updating the ClsName style will alter the appearance of every class name in the
booklet.
Disadvantages:
• Some duplication of changes are required between the schedule in AgShow and the Schedule
Booklet of the schedule.
7.4 Creating a PDF file of your Schedule to put onto your Web Page:
Even if you do not use AgShow to directly collate your Schedule Booklet, AgShow’s Print Schedule
should have sufficient information to place on your web page.
• From Print Schedule select the section to print with the options you require (usually schedules
are placed on the web by section)
• Print Preview, then select the ‘Output To PDF’ button on the toolbar.
(AgShow must be running under Microsoft Access 2007 or 2010 for this button to work.)
• Supply a filename and then you have that section in a PDF file.
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8. Advanced Topic: Within Word, using the AgShow Template to Import Class
details
The capabilities of Microsoft Word can be expanded to automatically insert AgShow Class details for a selected
section and subsection directly into the current word document. This feature makes the collation of the schedule
booklet easy, accurate and fast.
This feature is incorporated into Microsoft Word by loading the template file AgShow.dot from within Word.
Note that AgShow must also be running for this feature to work.
Also, this feature may not work with the AgShow Trial program.
8.1 Enabling Macros to run in Word
1. Macros must be enabled for this feature to work.
2. From within Word select
Tools → Options → Security → Macro Security
3. Either of the Medium or Low setting are okay. I recommend the Medium, but Word will continually display a
dialog box asking you if macros are to be enabled. Answer Yes when using this feature. Macros are always
enabled on the Low setting.
8.2 Installing the AgShow.dot Template
Installation of this component of AgShow is automatically performed when AgShow is installed. The procedure of
this installation is very simple. The AgShow installation program copies the file AGSHOW.DOT into your
AgShow directory, which is all that is required. However, if for some reason you cannot access the
AGSHOW.DOT template from within Word (see Loading the AgShow Template), probably because the
AGSHOW.DOT file has been deleted, then you may have to manually copy the AGSHOW.DOT file from the
AgShow directory into your Word Template directory. It is suggested you use the Windows Explorer for this task.
(If you do not feel confident with Windows Explorer or finding Word’s Template directory then call SoftShow for
online support to help you with this task. See
the
About AgShow window for the contact
number)
8.3 Loading the AgShow Template
1. Word 6 and 95: Select Templates from the
menu.
Word 97: Select Templates and Add-ins from
Insert menu
Word XP: Select Templates and Add-ins
the Tools menu

File
the
from

Word 2007:
a. Click the Microsoft Office Button
,
then click Word Options (located at
the
bottom).
b. Click Add-Ins (in the left column)
c. In the Manage drop-down list (at the
bottom), select Templates, and then
click
Go.
d. If AGSHOW.DOT is listed under Global templates and add-ins (similar to the screen just below) then
ensure it is checked and click OK
e. If AGSHOW.DOT is NOT listed click the Add button. The OpenFile Dialogue box appears. Navigate to
C:\AgShow and select the AGSHOW.DOT file
2. The Templates and Add-ins screen for Word XP should look something like the picture above.
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3. If this is the first time that you have tried to load this template then the AGSHOW.DOT template is not listed.
To find it press the Add button, then navigate to the folder C:\agshow to find it.
4. Simply ensure the AGSHOW.DOT is ticked as in the window above.
5. Close the Templates and Add-ins windows by clicking on the OK button.
6. Once back at the Word document screen, two items tell you the AgShow.dot template is loaded:
(i) A new option Insert AgShow Classes is listed at the bottom of Word’s Insert menu.
(ii) A new toolbar, called AgShowTBAR should be displayed on the screen, which looks like:

The four buttons are Increase Hanging Indent, Decrease Hanging Indent, Insert all of a Section’s Details and
Insert Classes into a Subsection.
You may find the Hanging Indent buttons useful for formatting long lines of text in the schedule.
If the AgShowTBAR toolbar is not displayed:
1. Select View --> Toolbars from Word’s top pull-down menus.
2. Click on the AgShowTBAR
3. Click OK to close the Toolbars window
8.4 Inserting AgShow Classes into Word for a Single Section
When inserting a section’s details, the following information can be selected:
(i)
the section’s header details
(ii)
subsection header information for each subsection in the section
(iii)
class details for every class within each subsection
These details for a selected section can be easily inserted into your current Word document at the current cursor
position. To perform this AgShow must be loaded into memory as well as Microsoft Word (with your document).
1.
Start AgShow and select the required .sho file
2.
Start Word with a blank document (I recommend loading the data into a blank document then using copypaste into your actual schedule).
3.
Click on the Section button on the AgShowTBAR toolbar:

4.

The following screen for selecting AgShow's section or subsection of the class details you require will be
displayed (your section names may be different):
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5.
6.
7.
8.

First select the section - this screen has selected section “A – Cooking”
Tick the fields that you wish to be included. In the screen above all fields are ticked!
Tick the Bold, Italics and Border options as required.
Be careful with borders, as they can make a paragraph stand out but it looks fairly ordinary when overdone.
Click the OK button and watch as the data from AgShow is inserted at the cursor position.

8.5 Inserting AgShow Classes into Word for a Single Subsection
1.
2.
3.
4.

Follow the same steps as for all of a section’s details above, then tick the Single Subsection option.
A list of subsection names for the selected section will appear, from which you select the required
subsection.
As section header details will not be inserted, the Section Header Details in the screen above will be
blanked out.
Tick your requirements then click OK.

8.6 Results of Inserting Classes from AgShow
The following are the results after pressing the OK button for the above selection screen:
Note:
1. All of the details have been inserted directly from from AgShow.
2. Often, all entry fees are the same for every class, so they may be better placed with the heading at the beginning
of the section or subsection. Similarly for the cash prize money.
3. However, where these fees and prizes differ from class-to-class it is more appropriate to print them for every
class.
4. I recommend loading this data into a blank document then using copy-paste into your actual schedule.
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8.7 Using Word’s Styles
When importing schedule details from AgShow into Word, if the “Use Word Styles for Formatting” is ticked
then each component of the schedule is assigned a style name. eg. AgsecName for the section heading.
Word Styles are a very powerful feature. A style is a set of formatting characteristics that you can apply to text,
tables and lists in your document to quickly change their appearance. When you apply a style, you apply a whole
group of formats in one simple task.
AgShow makes using styles quite easy as a “Modify Style” button is incorporated into the AgShow toolbar. Let’s
try it:
1. Start a new document and ensure the AgShow Toolbar is loaded (see above).
2. Click the “Section” button on the toolbar to load the Microsoft Word – AgShow Connection form.
3. Select section, subsection and class details as required (or as set out on the example above)
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4. Ensure that the “Use Word Styles for Formatting” is ticked.
5. Click OK to import the schedule
6. Once imported click on a section name. Note the AgsecName style is listed in the styles drop-down list on
Word’s Formatting toolbar.
7. In the AgShow Toolbar, click on “Modify Style” to bring up the following screen:

8. You can change the font, size, bold, italics, underline settings directly.
9. To change the background colour:
- open the Format menu and select the Border option
- select the Shading tab
- click on your favourite colour in the Fill colour chart
10. OK out of that and notice that every section heading is now formatted with your updated style.
11. Click on a class name and follow the same procedure. That is much more dramatic!

8.8 Unloading the AgShow Template
Open the Templates and Add-ins dialog box.
Ensure the AgShow.dot template is unticked.
Close the Templates and Add-ins window
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9. Advanced Topic: Control Your Memberships
AgShow’s membership module has many features to help you, including:
• Define your own Membership Categories
• Ability to specify many memberships for a contact
• Support for Family Memberships
• Support for GST including a Tax Invoice
• Membership lists and Membership Renewal Notices
• Integration with Microsoft Word’s Mail Merge feature that enables easy communication with
your members.
The following exercises use the sample show data file agshdemo.sho
Load the file from the Main Menu from the top menu File→ Open then select agshdemo.sho.
9.1 Defining a Membership Category and Category Fee:
Select Categories from the Memberships Menu.
Standard categories are Member and Life Member.
You may like to create new categories, such as Junior, Associate, Family etc.
A category that has members recorded for it cannot be deleted.
9.2 Specifying a Membership:
Select Memberships from the Memberships Menu.
A Contact is a person or company, who may be a member, an entrant, a steward, sponsor or
stallholder. Specifying a contact does not specify a membership.
Click the New Membership button to specify a membership for the current year.
Or, the the ‘Copy nnnn Memberships’ button to copy last years memberships (nnnn will specify the
previous year). This is especially useful if a contact is renewing many memberships, such as Family
Members, as the following screen displays.

9.3 Family Memberships:
AgShow supports Family Memberships very well, as shown in the above screen. First, create two
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new membership categories, say ‘Family Contact’ and ‘Family Member’ (You may prefer different
names):
• Family Contact: is the main family member. Set the family membership fees against this
category.
• Family Member: other members of the family membership. Set a fee of $0.
When allocating the memberships within the Memberships screen:
• Create a New Contact record for the family. (Create a new record in the agshdemo.sho data
file for yourself.) In the name fields enter the name of whoever communication is sent to.
(Note that creating a contact does not create a membership.)
• Add a membership to create a new membership. Select the ‘Family Contact’ membership
category and AgShow automatically assigns the fee and the main contact’s names against that
membership.
• Add memberships for each other members of the family in category ‘Family Member’. Enter
the names for each of these members. (Make up some family members.)
9.4 Membership Renewal Notices:
Also selected from the Memberships Menu.
Such notices are a key to maximising the Society’s membership renewal rate.
For the year of membership on the Renewal Notice, AgShow increases the current show year by one,
but this can be overwritten in the selection screen.
You may like to load the previous year’s data file when printing Renewal Notices, especially if you
have not rolled over memberships into the new year! But, if printing categories and fees, you may
need to edit the fees in the selection screen if they have altered.
Selection of members to print renewal notices for is very flexible:
• By Member Category and Year
For family memberships, only select the category ‘Family Contact’ so that only one renewal
notice is sent to the family.
• Or, Life Members Only (why? They should not require a Renewal Notice!)
• Or, select a single contact
• Or, select multiple contacts
• Or, all contacts
Options that you can include are:
• List of Membership Categories and fees (that you can edit). This is so the member knows
what categories are available. For example, family categories that they write new members
for. Fees are read from those specified in the Categories screen.
• Credit Card Payment Slip. This will also include your bank details for Direct Debits if the
bank details are entered in the Base Details form.
• Registered Entrants Info. Prints a sentence about including GST in prize money and that
entrants must supply a Company Name and ABN.
A new feature in AgShow Version 14 is the Membership Renewal Notice can also be Emailed to last years
members.
9.5 Sending a mass communication to your members with Word’s Mail Merge:
See the following topic on Integrating with Word’s Mail Merge.
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10. Advanced Topic: Integrating with Word’s Mail Merge
Keeping members, stewards, sponsors and entrants informed of what is required is a major task of the Show
Secretary. This is where AgShow’s Mail Merge feature can help.
Mail Merge is where a single document is written and many copies printed, or emailed, each individually
addressed to names read from records of a data file (or database).
AgShow creates such a data file from its database for Word to use.

10.1 AgShow's Mail Merge consists of 3 components:
i. Template Document: which is a previously created Word Mail Merge document containing data
fields, text, images etc. AgShow has installed some set templates and you can easily create your own
to add to them. A template is used as the basis for a new Merge Document.
ii. Data Source File: AgShow creates this file, fills it with the selected data and sets it as the Data
Source for the merged document.
iii. Merged Document: The Template Document is copied to this document and the Data Source File is
set as its Data Source.

10.2 AgShow's Mail Merge Selection screen:

Steps for setting up a Mail Merge for current members:
1. Check the ‘Select by Membership Data’ to enable the Memberships to be selected
2. Select the Years and Categories for members that you want to include in your Mail Merge.
3. Content: A contact can have many memberships, as shown for Ronald McDonald on a previous page.
If ‘Contact Names’ is selected the names are read from the Contacts (top part of the Membership
Subscription screen) and there is only one record per matching contact.
If ‘Membership Names’ is selected then the names are read from the individual memberships of a
contact. Note that a contact may have many matching memberships, so this will produce that many
records per contact in the mail merge.
4. ‘Mail Merge Template’ button is used to select the template that the merged file is based on. Note
that the template file is copied and not altered.
5. ‘Data File To Save To’ button specifies the Data Source file for your merged document.
6. ‘Merged Doc To Save To’ button specifies the final merged document. If you select a file that
already exists it is overwritten. The selected template file becomes the base for the content of the
merged document and the data source file is automatically connected by AgShow.
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7. ‘Collate Data’ button to collate the memberships data selected.
8. ‘Word Mail Merge’ button writes the selected data to the Data Source File and starts Word with your
selected template.

10.3 Inside Word Mail Merge:
A mail merge document consists of 2 separate parts:
1. Merge Document which contains data fields and Word text, formatting, images etc
2. Data Source which contains many records. The document is reproduced for every record in
the data source.
The following screen shows a mail merge document:

This is one of the templates installed with AgShow. Click the "ABC" button on the toolbar to replace
the merge fields with actual data. You can also use this template as a basis to create your own
templates.
Data fields are "title", "firstname" etc. The "firstname" field has been inserted twice. A field can be
inserted wherever you like and as many times as you like
The data fields at the top of the document have been inserted so as to form a mailing address.
When merged with the Data Source a copy of the document is made for every record in the Data
Source.
The document can be edited just like any other Word document, but changes made to one record
(page) affect every record's page.
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